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Preface

Audience and Use
The Cisco Unity Connection User Setup Guide contains information and instructions that system 
administrators can use for setting up user workstation access to Cisco Unity Connection web tools, for 
setting up user phones, for configuring e-mail accounts to access Connection voice messages, and for 
conducting orientation sessions for users.

Documentation Conventions

The Cisco Unity Connection User Setup Guide also uses the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Table 1 Cisco Unity Connection User Setup Guide Conventions 

Convention Description

boldfaced text Boldfaced text is used for:

 • Key and button names. (Example: Click OK.)

 • Information that you enter. (Example: Enter Administrator 
in the User Name box.)

< >

(angle brackets)

Angle brackets are used around parameters for which you supply 
a value. (Example: In the Command Prompt window, enter ping 
<IP address>.)

- 

(hyphen)

Hyphens separate keys that must be pressed simultaneously. 
(Example: Press Ctrl-Alt-Delete.)

> 

(right angle bracket)

A right angle bracket is used to separate selections that you make 
on menus. (Example: On the Windows Start menu, click 
Settings > Control Panel > Phone and Modem Options.)
v
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  Cisco Unity Connection Documentation
Caution Means reader be careful. In this situation, you might do something that could result in equipment damage 
or loss of data.

Cisco Unity Connection Documentation
For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the Cisco Unity 
Connection Documentation Guide. The document is shipped with Cisco Unity Connection and is 
available at 
http://www.cisco.com/en/US/products/ps6509/products_documentation_roadmaps_list.html.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
The Product Documentation DVD is a comprehensive library of technical product documentation on a 
portable medium. The DVD enables you to access multiple versions of installation, configuration, and 
command guides for Cisco hardware and software products. With the DVD, you have access to the same 
HTML documentation that is found on the Cisco website without being connected to the Internet. 
Certain products also have .PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com 
users (Cisco direct customers) can order a Product Documentation DVD (product number 
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/
vi
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Ordering Documentation
Registered Cisco.com users may order Cisco documentation at the Product Documentation Store in the 
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 5:00 p.m. 
(0800 to 1700) PDT by calling 1 866 463-3487 in the United States and Canada, or elsewhere by 
calling 011 408 519-5055. You can also order documentation by e-mail at 
tech-doc-store-mkpl@external.cisco.com or by fax at 1 408 519-5001 in the United States and Canada, 
or elsewhere at 011 408 519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by completing the online feedback 
form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if present) behind the 
front cover of your document or by writing to the following address:

Cisco Systems 
Attn: Customer Document Ordering 
170 West Tasman Drive 
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you will find information about how to:

 • Report security vulnerabilities in Cisco products.

 • Obtain assistance with security incidents that involve Cisco products.

 • Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco products is 
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you 
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) 
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
vii
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Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability 
in a Cisco product, contact PSIRT:

 • For Emergencies only — security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which 
a severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.

 • For Nonemergencies — psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

 • 1 877 228-7302

 • 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to 
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been 
encrypted with PGP versions 2.x through 9.x.  
 
Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page 
at this URL: 
 
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html 
 
The link on this page has the current PGP key ID in use. 
 
If you do not have or use PGP, contact PSIRT at the aforementioned e-mail addresses or phone numbers 
before sending any sensitive material to find other means of encrypting the data.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco 
Technical Support & Documentation website on Cisco.com features extensive online support resources. 
In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) 
engineers provide telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The website is 
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport
viii
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Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user 
ID and password. If you have a valid service contract but do not have a user ID or password, you can 
register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support & 
Documentation website by clicking the Tools & Resources link under Documentation & Tools. Choose 
Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click the Cisco 
Product Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by 
product ID or model name; by tree view; or for certain products, by copying and pasting show command 
output. Search results show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the information before placing a 
service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—An existing network is down, or there is a critical impact to your business operations. 
You and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operations are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.
ix
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Severity 3 (S3)—Operational performance of the network is impaired, while most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

 • The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief 
product overviews, key features, sample part numbers, and abbreviated technical specifications for 
many Cisco products that are sold through channel partners. It is updated twice a year and includes 
the latest Cisco offerings. To order and find out more about the Cisco Product Quick Reference 
Guide, go to this URL: 

http://www.cisco.com/go/guide

 • Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

 • Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

 • Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

 • iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

 • Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj
x
Cisco Unity Connection 1.x User Setup Guide

OL-8471-03

http://www.cisco.com/go/guide
http://www.cisco.com/go/marketplace/
http://www.ciscopress.com
http://www.cisco.com/packet
http://www.cisco.com/go/iqmagazine
http://ciscoiq.texterity.com/ciscoiq/sample/
http://www.cisco.com/ipj


  

Preface
  Obtaining Additional Publications and Information
 • Networking products offered by Cisco Systems, as well as customer support services, can be 
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

 • Networking Professionals Connection is an interactive website for networking professionals to share 
questions, suggestions, and information about networking products and technologies with Cisco 
experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

 • World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
xi
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C H A P T E R 1

Setting Up Access to the Cisco Personal 
Communications Assistant

The Cisco Personal Communications Assistant (PCA) is the portal that provides access to the 
Cisco Unity web tools for users to manage messages and personal preferences in Cisco Unity 
Connection. The Cisco Unity web tools include the Cisco Unity Assistant, the Cisco Unity Inbox, and 
the Cisco Unity Personal Call Transfer Rules. The Cisco PCA is installed on the Connection server 
during installation.

See the following sections in this chapter:

 • Configuring an Internet Browser to Access the Cisco PCA, page 1-1

 • Securing and Changing the Cisco PCA Password, page 1-3

 • Customizing the Cisco Unity Inbox for a Low-Bandwidth Deployment, page 1-4

 • Managing Security Alerts When Using SSL, page 1-5

Configuring an Internet Browser to Access the Cisco PCA
The browser(s) on each user workstation must be set up to use the Cisco PCA and the web tools. See the 
applicable section, depending on the browser(s) installed on the computer:

 • Apple Safari, page 1-2

 • Microsoft Internet Explorer, page 1-2

 • Mozilla Firefox, page 1-2

(For information on browser version support, see the Compatibility Matrix: Cisco Unity Connection and 
the Software on User Workstations, available at 
http://www.cisco.com/en/US/products/ps6509/products_device_support_tables_list.html.)

To change the GUI language used in the Cisco PCA, select a language in the Internet browser. The 
language selected in the browser must be one of the languages that the Cisco PCA offers. For a list of 
supported languages, see the “Available Languages for Cisco Unity Connection Components” section of 
the Release Notes for Cisco Unity Connection, at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.
1-1
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  Configuring an Internet Browser to Access the Cisco PCA
Apple Safari

Do the following tasks to set up Safari for accessing the Cisco PCA.

1. Install the latest Java 2 Platform, Standard Edition (J2SE) Runtime Environment 5.0 Release 3 or 
later.

2. Configure Safari:

a. Enable Java.

b. Enable Java Script.

c. Accept cookies only from sites that you navigate to.

Microsoft Internet Explorer

Do the following tasks to set up Internet Explorer for accessing the Cisco PCA.

1. Install the latest Java 2 Platform, Standard Edition (J2SE) Runtime Environment 5.0 Update 6 
(1.5.0_06) or later.

2. Configure Internet Explorer:

a. Enable Active scripting.

b. Download and run ActiveX controls.

c. Enable Java scripting.

d. Accept First-Party Cookies. (Note: You can also safely configure Internet Explorer to block 
third-party cookies, if needed.)

e. Automatically check for newer versions of temporary Internet files.

f. Enable Medium-High privacy.

Mozilla Firefox

Do the following tasks to set up Firefox for accessing the Cisco PCA.

1. Install the applicable software, depending on the computer operating system:

Mac OS X a. Install the latest Java 2 Platform, Standard Edition (J2SE) Runtime 
Environment 5.0 Release 3 or later.

b. Install Java Embedding Plugin for Mac OS X version 0.9.5 or later.1
1-2
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  Securing and Changing the Cisco PCA Password
2. Configure Firefox:

a. Enable Java.

b. Enable Java Script > Enable Change Images in Java Script Advanced.

c. Allow sites to set cookies. (For security purposes, we recommend that you set this to Allow 
Sites to Set Cookies for the Originating Web Site Only.)

Securing and Changing the Cisco PCA Password
Users enter a user name and password to log on to the Cisco PCA. The Cisco PCA password is not 
related to the Cisco Unity Connection phone password, and the two are not synchronized.

Note The Cisco PCA password is referred to as the “Web Application Password” in Cisco Unity Connection 
Administration.

You can change user passwords in Cisco Unity Connection Administration after you create user 
accounts. Each user should be assigned a unique password. Connection requires that you specify a 
long—eight or more characters—and nontrivial password. For the Cisco PCA, a nontrivial password has 
the following attributes:

 • The password must contain at least three of the following four characters: an uppercase character, a 
lowercase character, a number, or a symbol.

 • The password cannot contain the user name or its reverse.

 • The password cannot contain the primary extension or its reverse.

 • A character cannot be used more than three times consecutively (for example, !Cooool).

 • The characters cannot all be consecutive, in ascending or descending order (for example, abcdef or 
fedcba).

Red Hat a. Confirm that you are using the correct sound card by referring to the sound card 
support matrix on the Alsa-project.org website.

Note The J2SE software uses the Advanced Linux Sound Architecture (ALSA) 
driver to access system sound devices and control playback and recording 
functionality. Depending on the sound card, playback and recording 
capabilities may be limited.

b. Install the Advanced Linux Sound Architecture (ALSA) driver version 1.0.9 or 
later from the Alsa-project.org website.

c. Install the latest Java 2 Platform, Standard Edition (J2SE) Runtime 
Environment 5.0 Update 6 (1.5.0_06) or later. 

Windows Install the latest Java 2 Platform, Standard Edition (J2SE) Runtime Environment 5.0 
Update 6 (1.5.0_06) or later.

1. The Java Embedding Plugin for Mac OS X is included with Firefox version 1.5.0.1 and later.
1-3
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  Customizing the Cisco Unity Inbox for a Low-Bandwidth Deployment
Depending on how you set up user accounts, you can require users to change their Cisco PCA password 
the first time they log on. Encourage users to enter secure passwords whenever they change their 
Cisco PCA password, or set your secure password policy for the Cisco PCA to require them to do so. 
Logon, password, and lockout policies are defined on the Edit Authentication Rules page in 
Connection Administration.

Users can change the Cisco PCA password only in the Cisco Unity Assistant; they cannot change it by 
using the Connection conversation.

Users may assume that their phone and Cisco PCA passwords are the same. As a result, they may think 
that they are changing both passwords when the Connection conversation prompts them to change their 
phone password during first-time enrollment. For this reason, you may find that many users do not 
consider securing their Cisco PCA passwords, even though you request that they do so.

Default voice mail and web application passwords are applied to each user account that you create. These 
passwords are either the defaults set for the default Voice Mail User Template during installation (set on 
the Set Default User Template Password page of the Cisco Unity Connection Configuration Assistant), 
or defaults that are set on the Change Password page for the user template that you select when creating 
the accounts. To increase system security, be sure to tell users to change both passwords as soon as 
possible, and that you enforce password complexity rules. 

Customizing the Cisco Unity Inbox for a Low-Bandwidth 
Deployment

If users play recordings by using computer speakers in a low-bandwidth deployment (for example, with 
a slow modem or in a branch office), they should download messages before playing them for best 
performance and quality.

To customize the Cisco Unity Inbox so that messages are downloaded rather than streamed from the 
Cisco Unity Connection server during playback, do the following procedure to change the Performance 
setting on each user workstation (as applicable). Alternatively, refer users to the Cisco Unity Connection 
User Guide for procedures on how to change this setting.

To Customize the Cisco Unity Inbox to Download Messages Before Playing Them

Step 1 On the Cisco PCA Home page, click the Cisco Unity Inbox link.

Step 2 In the Cisco Unity Inbox, go to a page that contains a Media Master. (For example, click the New 
Message icon to open a new message window.)

Step 3 On the Media Master Options menu, click Playback & Recording.

Step 4 In the Playback and Recording Settings dialog box, under Performance, click Download Complete 
Message Before Playing.

Step 5 Click OK.
1-4
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Managing Security Alerts When Using SSL
If you installed an SSL certificate on the Cisco Unity Connection server to secure Cisco PCA access to 
Connection, you probably will also want to add the certificate to the Trusted Root Store on user 
workstations. If you do not install the certificate on user workstations, users can use Cisco PCA, but the 
web browser will display a message to alert the user that the authenticity of the site cannot be verified, 
and therefore its content cannot be trusted. Connection may also display this warning message if the 
URL used to connect to the Connection server is different from the hostname of the server at the time 
the Cisco Unity Connection software was installed.

If you installed an SSL certificate to secure IMAP e-mail client access to Connection, you may need to 
add the certificate to the Trusted Root Store on user workstations. Some of the IMAP e-mail clients 
supported for use with Connection display SSL security messages, while others do not.

For situations where the client computer is running Windows Server 2003 and a user is using Internet 
Explorer 6.0 to access the Cisco Personal Communications Assistant, provide the user with the 
following “Adding the Cisco Unity Connection Server to the List of Trusted Sites for Internet Explorer 
2003” procedure to add the Cisco Unity Connection server to the list of Trusted Sites. These additional 
configuration steps must be performed for these user workstations in order for the Cisco PCA to work 
correctly.

Adding the Cisco Unity Connection Server to the List of Trusted Sites for Internet Explorer 2003

Step 1 Open the Cisco Personal Communications Assistant Login page. It is not necessary to log in to the 
Cisco PCA.

Step 2 On the Internet Explorer File menu, click Add This Site To > Trusted Sites Zone.

Step 3 In the Trusted Sites dialog box, click Add.

Step 4 Click Close to close the Trusted Sites dialog box.

Step 5 Restart Internet Explorer.
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Setting Up Playback and Recording Devices for 
the Media Master

The Media Master is used to make and play recordings in the Cisco Unity web tools.

See the following sections in this chapter:

 • About the Media Master, page 2-1

 • Determining Which Recording and Playback Devices Users Will Use for the Media Master, page 2-2

 • How Users Specify Their Recording and Playback Device Preferences, page 2-3

About the Media Master
The Media Master appears on the pages of the Cisco Unity Inbox and Cisco Unity Personal Call Transfer 
Rules web tools on which users can make or play recordings. Depending on how Cisco Unity Connection 
is set up, the Media Master may also appear on some Cisco Unity Assistant pages. Users can use the 
phone or the computer microphone and speakers with the Media Master controls to make and play 
recordings.

Figure 2-1 Media Master Control Bar
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The Media Master is a Java 2 Platform, Standard Edition (J2SE) application, and the Java plug-in 
component must be installed on the user workstation for it to run properly.

Note Depending on the Internet browser, if the Java plug-in component is not installed, the Media Master will 
not appear in the browser window or the user will be prompted to install the component. (See the 
“Configuring an Internet Browser to Access the Cisco PCA” section on page 1-1.)

Before users start using the Cisco Unity web tools that offer the Media Master, specify that Connection 
has at least one voice messaging port designated to allow users to use the phone as a recording and 
playback device, by adjusting the Allow TRAP Connections setting on the Telephony Integrations > Port 
page in Cisco Unity Connection Administration. See the “Changing Port Settings” section of the 
“Managing the Phone System Integrations” chapter of the Cisco Unity Connection System 
Administration Guide for instructions. (The guide is available at 
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.) Alternatively, 
provide sound cards, earphones or speakers, and microphones to users who do not want to use the phone 
as their recording and playback device.

Determining Which Recording and Playback Devices Users 
Will Use for the Media Master

When determining the recording and playback devices that you want users to use, note the following 
considerations:

 • The phone offers the best sound quality for recordings, and serves as the default recording and 
playback device for the Media Master.

 • In order for users to use the phone as a recording and playback device, Cisco Unity Connection must 
have at least one voice messaging port designated for this purpose. Note that when a user listens to 
messages or other recordings by using a computer microphone and speakers, no ports are used, 
which decreases the load on the Connection server and leaves ports open for other functions.

 • You must provide sound cards, speakers, and microphones to users who do not want to use the phone 
as their recording and playback device.

See the following sections for detailed descriptions of the events that occur when using the phone or the 
computer microphone and speakers for recording and playback:

 • What Happens When the Phone Is Used as the Recording and Playback Device, page 2-3

 • What Happens When a Computer Microphone and Speakers Are Used as the Recording and 
Playback Devices, page 2-3

1 Options menu 7 Stop

2 Recording/playback progress 8 Pause

3 Record list 9 Play

4 Help menu 10 Volume control

5 Playback speed control 11 Playback list

6 Record   
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What Happens When the Phone Is Used as the Recording and Playback Device
When users use the phone as a recording and playback device in the web tools accessed through the 
Cisco PCA (and in Cisco Unity Connection Administration), the following events occur:

1. The user clicks the applicable option in the client application to make or play a recording.

2. The client application asks Cisco Unity Connection to place a call to the user extension, and 
Connection calls the extension.

3. When making a recording, the user answers the phone, and begins recording the message, name, or 
greeting. When the user hangs up, the client application tells Connection that the recording is 
finished.

4. When playing a recording, the user answers the phone, and the client application asks Connection 
to play the message. Connection streams the recording over the phone.

What Happens When a Computer Microphone and Speakers Are Used as the 
Recording and Playback Devices

When users use a computer microphone and speakers as the recording and playback devices, the 
following events occur:

1. The user clicks the applicable option in the client application to make or play a recording.

2. When making a recording, the user begins speaking into the microphone. When the user clicks the 
applicable option in the client application to stop recording, the client application tells Cisco Unity 
Connection that the recording is finished.

3. When playing a recording, Connection streams the message to the client application. Streaming 
occurs on demand, regardless of network traffic. The client application begins to play the message 
through the speakers as soon as a few seconds of the message are buffered in memory on the user 
workstation.

How Users Specify Their Recording and Playback Device 
Preferences

Users can set their own recording and playback device preferences. For example, the Options menu in 
the Media Master allows users to choose their own recording and playback devices. Media Master 
recording and playback settings are saved per user, per workstation. This means that:

 • A user can change recording and playback devices from the Options menu and from both the 
Playback and Record lists of any Media Master on the web-tool pages. The recording and playback 
devices that a user chooses apply to all Cisco Unity web tools, as long as the user accesses the 
applications from the same workstation on which the changes were initially made.

 • If multiple users share the same workstation, each user who uses the workstation must indicate a 
choice of recording and playback devices.

 • If a user has updated the choice of recording and playback devices from one workstation but also 
accesses the web tools on a different workstation (for example, from a computer at home), the choice 
of recording and playback devices must be indicated for the second workstation as well.
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Configuring an E-Mail Account to Access 
Cisco Unity Connection Voice Messages

Cisco Unity Connection allows licensed users to use a third-party IMAP client to access voice messages 
from their desktop machines. Currently, it is possible only to play voice messages with the IMAP client; 
there are no reply or forwarding capabilities.

See the following sections in this chapter:

 • Configuring Cisco Unified Personal Communicator, page 3-1

 • Creating and Configuring an Account in Apple Mail, page 3-2

 • Creating and Configuring an Account in Entourage, page 3-3

 • Creating and Configuring an Account in Eudora, page 3-5

 • Creating and Configuring an Account in IBM Lotus Notes, page 3-6

 • Creating and Configuring an Account in Microsoft Outlook, page 3-8

 • Creating and Configuring an Account in Microsoft Outlook Express, page 3-9

 • Creating and Configuring an Account in Netscape, page 3-11

 • Creating and Configuring an Account in Novell GroupWise, page 3-12

 • Creating and Configuring an Account in Opera, page 3-14

 • Creating and Configuring an Account in Thunderbird, page 3-15

Regardless of which IMAP client application you use, if users change their Cisco Unity Connection web 
application password used to access the Cisco Personal Communications Assistant from the Cisco Unity 
Assistant, they also must update this password from their IMAP client application. Passwords are not 
automatically synchronized between third-party IMAP clients and the Cisco Personal Communications 
Assistant. Users must manually change their password in the IMAP client each time the Cisco PCA 
password changes so they can continue using the IMAP client to access their Connection account and 
retrieve voice messages. See the “Troubleshooting IMAP Client Logon Problems” section on page 3-16 
for instructions.

Configuring Cisco Unified Personal Communicator
To use Cisco Unified Personal Communicator to access Cisco Unity Connection voice messages, you 
add the following information to Personal Communicator.

 • Connection user name.
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 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

For information on configuring Cisco Unified Personal Communicator to access Cisco Unity 
Connection voice messages, see the User Guide for Cisco Unified Personal Communicator at 
http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html, or the Cisco 
Unified Personal Communicator Help.

Creating and Configuring an Account in Apple Mail
To use Apple Mail to access Cisco Unity Connection voice messages, create and configure a new Apple 
Mail account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Apple Mail

Step 1 Start Apple Mail.

Step 2 In Apple Mail, on the Mail menu, click Preferences.

Step 3 At the top of the Preferences dialog box, click Accounts.

Step 4 In the lower left corner, click +.

Step 5 In the Account Type list, click IMAP.

Step 6 In the Description field, enter a name for the account. This name appears only in Apple Mail.

Step 7 In the E-Mail Address field, enter the Connection alias of the user and the name of the Connection server. 
Use the following format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Full Name field, enter the user name.

Step 9 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 In the User Name field, enter the Connection user name.

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 In the Outgoing Mail Server (SMTP) field, click the IP address or the fully qualified domain name of the 
Connection server.

The Connection server does not actually function as an outgoing e-mail server, but you must specify a 
value to proceed to the next page.

Step 13 Click Server Settings.
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Step 14 Optionally, in the SMTP Server Options dialog box, check the Use Secure Sockets Layer (SSL) check 
box.

Caution If you do not configure Apple Mail to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
will not be encrypted.

Step 15 In the Authentication list, click Password.

Step 16 Click OK to close the SMTP Options dialog box.

Step 17 Click the Advanced tab.

Step 18 In the Keep Copies of Messages for Offline Viewing list, choose the applicable option.

Step 19 Close the Preferences dialog box.

Step 20 In the Save Changes dialog box, click Save.

Creating and Configuring an Account in Entourage
To use Entourage to access Cisco Unity Connection voice messages, create and configure a new 
Entourage account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Entourage

Step 1 Start Entourage.

Step 2 On the Entourage Tools menu, click Accounts.

Step 3 In the Accounts dialog box, click New.

Step 4 In the Account Setup Assistant, enter the Connection alias of the user and the name of the Connection 
server. Use the following format:

<alias>@<fully qualified domain name of Connection server>

Step 5 Click the right arrow.

If the Automatic Configuration Failed dialog box appears, click the right arrow.

Step 6 On the Verify and Complete Settings page, enter the following values:

a. In the Your Name field, enter the user name.

b. The E-Mail Address field should contain the value that you entered in Step 4. If it does not, change 
it to that value.

c. In the Account ID field, enter the Connection user name. This may or may not be the same as the 
Connection alias.
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d. In the Password field, enter the Cisco PCA password.

e. In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

f. In the Incoming Mail Server Type list, click IMAP.

g. In the Outgoing Mail Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

The Connection server does not actually function as an outgoing e-mail server, but you must specify 
a value to proceed to the next page.

h. Click the right arrow.

Step 7 On the Optional: Verify Settings page, if you want to verify settings, click Verify My Settings, and do 
the following sub-steps:

a. If the verification fails, troubleshoot the problem.

b. If the verification succeeds, click the right arrow and continue with Step 8.

If you do not want to verify settings, click the right arrow, and the Do You Want to Verify Your Account 
Settings message appears. Click Skip.

Step 8 On the Setup Complete page, in the Account Name field, enter a display name for this account. The 
display name appears only in Entourage.

Step 9 Check or uncheck other options as applicable.

Step 10 Click Finish.

Step 11 In the Accounts dialog box, click the account, and click Edit.

Step 12 Click the Options tab.

Step 13 Uncheck the Partially Receive Messages Over check box.

Step 14 Click the Advanced tab.

Step 15 Uncheck the following three check boxes:

 • Store Sent Messages in This IMAP Folder

 • Store Drafts in This IMAP Folder

 • Store Junk E-Mail in This IMAP Folder

Step 16 Click Mark Messages As Deleted.

Step 17 Choose when deleted messages are purged.

Step 18 Optionally, configure Entourage to use SSL when sending the user name and password over the network.

Caution If you do not configure Entourage to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
will not be encrypted.

a. Click the Account Settings tab.

b. Click Click Here for Advanced Receiving Options.
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c. In the popup window, check the This IMAP Service Requires a Secure Connection (SSL) check 
box.

d. Close the popup window.

Step 19 Click OK to close the Edit Account dialog box. 

Step 20 Close the Accounts dialog box.

Creating and Configuring an Account in Eudora
To use Eudora to access Cisco Unity Connection voice messages, create and configure a new Eudora 
account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Eudora

Step 1 Start Eudora.

Step 2 On the Eudora Tools menu, click Personalities.

Step 3 Right-click anywhere in the Personalities tab, and click New.

Step 4 In the New Account wizard, on the Account Settings page, click Next to accept the default value, Create 
a Brand New E-Mail Account.

Step 5 On the Personality Name page, enter a display name for the account. The value that you enter here is 
visible only in Eudora.

Step 6 Click Next.

Step 7 On the Personal Information page, enter the user name.

Step 8 Click Next.

Step 9 On the E-Mail Address page, enter the Connection alias of the user and the name of the Connection 
server. Use the following format:

<alias>@<fully qualified domain name of the Connection server>

Step 10 Click Next.

Step 11 On the User Name page, enter the Connection user name. This may or may not be the same as the 
Connection alias.

Step 12 Click Next.

Step 13 On the Incoming E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.
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Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 For the type of server, click IMAP.

Step 15 Click Next.

Step 16 On the IMAP Location Prefix page, do not enter a value.

Step 17 Click Next.

Step 18 On the Outgoing E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.

The Connection server does not actually function as an outgoing e-mail server, but you must specify a 
value to proceed to the next page.

Step 19 Click Next.

Step 20 On the Success page, click Finish to create the account and close the wizard.

Step 21 In the Enter Password dialog box, enter the Cisco PCA password of the user.

Step 22 Click OK.

Step 23 Optionally, configure the new account to use SSL. For more information, see Eudora Help.

Caution If you do not configure Eudora to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection will 
not be encrypted.

Creating and Configuring an Account in IBM Lotus Notes
You can use IBM Lotus Notes to access Cisco Unity Connection voice messages only if 
Connection 1.2(1) ES 2 is installed on the Connection server. ES 2 is available at 
http://www.cisco.com/cgi-bin/tablebuild.pl/unityconnection.

To use Notes to access Connection voice messages, create and configure a new Notes account for the 
user. You will need the following information:

 • Connection alias.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in IBM Lotus Notes

Step 1 Start IBM Lotus Notes.

Step 2 On the Notes File menu, click Preferences > Client Reconfiguration Wizard.

Step 3 In the Lotus Notes Client Configuration wizard, on the Additional Services page, check the Internet 
Mail Servers (POP or IMAP, SMTP) check box.
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Step 4 Click Next.

Step 5 On the Set Up Internet Mail page, in the Select the Type of Server Used for Retrieving Incoming Mail 
list, click IMAP.

Step 6 In the Enter a New Account Name list, click Incoming Internet Mail. 

Step 7 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Cisco Unity Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 Click Next.

Step 9 On the Set Up Internet Mail page, in the Account Name field, enter the Connection alias of the user and 
the IP address or the fully qualified domain name of the Connection server. Use the following format:

<alias>@<IP address or fully qualified domain name of the Connection server>

Step 10 In the Password fields, enter and confirm the Cisco PCA password of the user.

Step 11 If you want to encrypt voice messages and other data that are sent between Notes and Connection, check 
the Log On Using SSL check box. If not, skip to Step 12.

Caution If you do not configure Notes to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages that are sent back from 
Connection will not be encrypted.

Step 12 Click Next.

Step 13 On the second Set Up Internet Mail page, in the Enter a New Account Name list, click Outgoing 
Internet Mail. 

The Connection server does not actually function as an outgoing e-mail server, but you must specify a 
value to proceed to the next page.

Step 14 In the Outgoing SMTP Mail Server list, enter the IP address or the fully qualified domain name of the 
Connection server.

Step 15 Click Next.

On the third Set Up Internet Mail page, in the E-Mail Address field, enter the Connection alias of the 
user and the name of the Connection server. Use the following format:

<alias>@<fully qualified domain name of the Connection server>

Step 16 In the Internet Domain field, enter the Internet domain name of the Domino mail server.

Step 17 Click Next.

Step 18 Click OK.
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Creating and Configuring an Account in Microsoft Outlook
To use Outlook to access Cisco Unity Connection voice messages, create and configure a new Outlook 
account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Outlook

Step 1 Start Outlook.

Step 2 On the Outlook Tools menu, click E-Mail Accounts.

Step 3 In the E-Mail Accounts wizard, click Add a New E-Mail Account.

Step 4 Click Next.

Step 5 On the Server Type page, click IMAP.

Step 6 Click Next.

Step 7 Enter values in the User Information section:

a. In the Your Name field, enter a display name for the account. The value that you enter here is visible 
only in Outlook.

b. In the E-Mail Address field, enter the Connection alias of the user and the name of the Connection 
server. Use the following format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 Enter values in the Server Information Section:

a. In the Incoming Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

b. In the Outgoing Server field, click the IP address or the fully qualified domain name of the 
Connection server.

The Connection server does not actually function as an outgoing e-mail server, but you must specify 
a value to proceed to the next page.

Step 9 Enter values in the Logon Information section:

a. In the User Name field, enter the Connection user name.

b. In the Password field, enter the Cisco PCA password of the user.

c. Verify that the Remember Password check box is not checked. If this option is checked, and the 
Connection password of the user expires, changes, or is locked, Microsoft Outlook will not prompt 
the user to enter the Connection password. The result is that users will not receive voice messages 
from Connection.
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Step 10 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook and Connection, skip to Step 15.

Caution If you do not configure Outlook to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection will 
not be encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook and Connection, 
continue with Step 11.

Step 11 Click More Settings.

Step 12 In the Internet E-Mail Settings dialog box, click the Advanced tab.

Step 13 Under Incoming Server (IMAP), check the This Server Requires an Encrypted Connection (SSL) 
check box.

Step 14 Click OK to close the Internet E-Mail Settings dialog box.

Step 15 Click Next.

Step 16 Click Finish.

Step 17 In the left pane of Outlook, click the Inbox folder for the new account.

Step 18 On the Outlook Tools menu, click Send/Receive > This Folder.

Step 19 If prompted, enter the Connection user name and Cisco PCA password.

Creating and Configuring an Account in Microsoft Outlook 
Express

To use Outlook Express to access Cisco Unity Connection voice messages, create and configure a new 
Outlook Express account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Outlook Express

Step 1 Start Outlook Express.

Step 2 On the Outlook Express Tools menu, click Accounts.

Step 3 In the Internet Accounts dialog box, click the Mail tab.

Step 4 Click Add > Mail, and the Internet Connection wizard appears.

Step 5 On the Your Name page, in the Display Name field, enter the user name.

Step 6 Click Next.
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Step 7 On the Internet E-Mail Address page, click I Already Have an E-Mail Address That I'd Like to Use.

Step 8 In the E-Mail Address field, enter the Connection alias and the name of the Connection server. Use the 
following format:

<alias>@<fully qualified domain name of the Connection server>

Step 9 Click Next.

Step 10 On the E-Mail Server Names page, in the My Incoming Mail Server Is a <protocol> Server list, click 
IMAP.

Step 11 In the Incoming Mail (POP3, IMAP, or HTTP) Server field, enter the IP address or the fully qualified 
domain name of the Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 12 In the Outgoing Mail (SMTP) Server field, enter the IP address or the fully qualified domain name of 
the Connection server.

The Connection server does not actually function as an outgoing e-mail server, but you must specify a 
value to proceed to the next page.

Step 13 Click Next.

Step 14 On the Internet Mail Logon page, in the Account Name and Password fields, enter the Connection user 
name and Cisco PCA password. The user name may or may not be the same as the alias.

Step 15 Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
Microsoft Outlook Express will not prompt the user to enter the Connection password. The result is that 
users will not receive voice messages from Connection.

Step 16 Click Next.

Step 17 On the Congratulations page, click Finish.

Step 18 In the Internet Accounts dialog box, click the account that you created in Step 4, and click Properties.

Step 19 In the <account name> Properties dialog box, click the IMAP tab.

Step 20 Uncheck the Store Special Folders check box.

Step 21 In the Root Folder Path field, enter INBOX (all upper-case letters).

Step 22 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook Express and Connection, skip to Step 25. 

Caution If you do not configure Outlook Express to use SSL, the Connection user name and password 
that are sent to Connection over the network and the voice messages sent back from 
Connection will not be encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook Express and 
Connection, continue with Step 23.

Step 23 Click the Advanced tab.

Step 24 Under Incoming Mail, check the This Server Requires a Secure Connection (SSL) check box.

Step 25 Click OK to close the <account name> Properties dialog box.
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Step 26 Click Close to close the Internet Accounts dialog box.

Creating and Configuring an Account in Netscape
To use Netscape to access Cisco Unity Connection voice messages, create and configure a new Netscape 
account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Netscape

Step 1 Start Netscape.

Step 2 On the Netscape Edit menu, click Mail & Newsgroups Account Settings.

Step 3 On the Mail & Newsgroups Account Settings dialog box, click Add Account.

Step 4 In the Account wizard, click Email Account.

Step 5 Click Next.

Step 6 On the Identity page, in the Your Name field, enter the user name.

Step 7 In the Email Address field, enter the Connection alias and the name of the Connection server. Use the 
following format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 Click Next.

Step 9 On the Server Information page, under Select the Type of Incoming Server You Are Using, click IMAP.

Step 10 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 11 In the Outgoing Mail (SMTP) Server field, enter the IP address or the fully qualified domain name of 
the Connection server.

The Connection server does not actually function as an outgoing e-mail server, but you must specify a 
value to proceed to the next page.

Step 12 Click Next.

Step 13 On the User Name page, enter the Connection user name.

Step 14 Click Next.

Step 15 On the Account Name page, enter a name for the account. This name appears only in Netscape.

Step 16 Click Next.

Step 17 On the Congratulations page, confirm that the settings are correct, then click Finish.
3-11
Cisco Unity Connection 1.x User Setup Guide

OL-8471-03



  

Chapter 3      Configuring an E-Mail Account to Access Cisco Unity Connection Voice Messages
  Creating and Configuring an Account in Novell GroupWise
Step 18 If you do not want to encrypt voice messages and other data that are sent over the network between 
Netscape and Connection, skip to Step 21. 

Caution If you do not configure Netscape to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection will 
not be encrypted.

If you want to encrypt voice messages and other data that are sent between Netscape and Connection, 
continue with Step 19.

Step 19 In the left pane of the Mail & Newsgroups Account Settings dialog box, under the name of the account 
that you just created, click Server Settings.

Step 20 Check the Use Secure Connection (SSL) check box.

Step 21 Click OK to close the Mail and Newsgroups Account Settings dialog box.

Creating and Configuring an Account in Novell GroupWise
To use GroupWise to access Cisco Unity Connection voice messages, create and configure a new 
GroupWise account for the user. You will need the following information: 

 • Connection alias.

 • Connection user name.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in GroupWise

Step 1 Start GroupWise. 

Step 2 On the GroupWise Tools menu, click Accounts > Account Options. 

Step 3 In the Accounts dialog box, click Add. 

Step 4 In the Create Account dialog box, in the Account Name field, enter a name for the account. This name 
appears only in GroupWise.

Step 5 In the Account Type list, click IMAP4. 

Step 6 Click Next.

Step 7 In the Create Internet Account dialog box, in the Incoming Mail Server (IMAP4) field, enter the IP 
address or the fully qualified domain name of the Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 In the Login Name field, enter the Connection user name. 
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Step 9 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

The Connection server does not actually function as an outgoing e-mail server, but you must specify a 
value to proceed to the next page.

Step 10 In the E-Mail Address field, enter the Connection alias and the name of the Connection server. Use the 
following format:

<alias>@<fully qualified domain name of the Connection server>

Step 11 In the From Name field, enter the user name. 

GroupWise enters this value in the From field in messages that the user sends. However, Connection does 
not support sending voice messages from GroupWise, so this value will never be used.

Step 12 Click Next. 

Step 13 Follow the on-screen prompts to complete the configuration.

Step 14 If you do not want to encrypt voice messages and other data that are sent over the network between 
GroupWise and Connection, skip to Step 20. 

Caution If you do not configure GroupWise to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
will not be encrypted.

If you want to encrypt voice messages and other data that are sent between GroupWise and Connection, 
continue with Step 15.

Step 15 In the Accounts dialog box, click the name of the account that you just created.

Step 16 Click Properties.

Step 17 Click the Advanced tab.

Step 18 Under Incoming Mail Server (IMAP4), check the Use SSL check box.

Step 19 Click OK to close the <Account Name> Properties dialog box.

Step 20 Click Close to close the Accounts dialog box.

Step 21 Create the inbox for the new account, and download Connection voice messages:

a. In the left pane of GroupWise, click the name of the new account.

b. In the Logon to <AccountName> dialog box, enter the PCA password for the user.

c. Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
GroupWise will not prompt the user to enter the Connection password. The result is that users will 
not receive voice messages from Connection.

d. Click OK to close the Logon to <AccountName> dialog box.

e. With the name of the new account still selected in the left pane, on the GroupWise Tools menu, click 
Send/Receive > This Folder.
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Creating and Configuring an Account in Opera
To use Opera to access Cisco Unity Connection voice messages, create and configure a new Opera 
account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • Cisco Personal Communications Assistant (PCA) password. (If you are an administrator, this is the 
web application password that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Opera

Step 1 Start Opera.

Step 2 On the Opera Tools menu, click Mail and Chat Accounts.

Step 3 In the Manage Accounts dialog box, click New. 

Step 4 In the New Account wizard, click IMAP. 

Step 5 Click Next.

Step 6 In the Real Name field, enter the account name. 

Step 7 In the E-Mail Address field, enter the Connection alias and the name of the Connection server. Use the 
following format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Organization field, enter the applicable value.

Step 9 Click Next. 

Step 10 In the Login Name field, enter the Connection user name. 

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 Click Next. 

Step 13 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 If you want to encrypt voice messages and other data that are sent between Opera and Connection, check 
the Use Secure Connection (TLS) check box. (TLS is an updated version of SSL.)

Caution If you do not configure Opera to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection will 
not be encrypted.

Step 15 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.
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The Connection server does not actually function as an outgoing e-mail server, but you must specify a 
value to proceed to the next page.

Step 16 Click Finish.

Step 17 Click OK to close the Subscribe IMAP Folders dialog box. 

Step 18 Click OK to close the Manage Accounts dialog box. 

Creating and Configuring an Account in Thunderbird
To use Thunderbird to access Cisco Unity Connection voice messages, create and configure a new 
Thunderbird account for the user. You will need the following information:

 • Connection alias.

 • Connection user name.

 • The IP address or (if DNS is configured) the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Thunderbird

Step 1 Start Thunderbird.

Step 2 On the Thunderbird File menu, click New > Account.

Step 3 In the Account wizard, on the New Account Setup page, click E-Mail Account.

Step 4 Click Next.

Step 5 On the Identity page, in the Your Name field, enter the user name.

Step 6 In the E-Mail Address field, enter the Connection alias and the name of the Connection server. Use the 
following format:

<alias>@<fully qualified domain name of the Connection server>

Step 7 Click Next.

Step 8 On the Server Information page, under Select the Type of Incoming Server You Are Using, click IMAP.

Step 9 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 Click Next.

Step 11 On the User Names page, enter the Connection user name.

Step 12 Click Next.

Step 13 On the Account Name page, enter a name for the account. This name appears only in Thunderbird.

Step 14 Click Next.

Step 15 On the Congratulations page, confirm that the settings are correct, then click Finish.
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Step 16 If you do not want to encrypt voice messages and other data that are sent over the network between 
Thunderbird and Connection, you are finished creating and configuring a new account. 

If you want to encrypt voice messages and other data that are sent between Thunderbird and Connection, 
continue with Step 17.

Step 17 In the left pane of Thunderbird, click the name of the account that you just created.

Step 18 In the right pane of Thunderbird, under Accounts, click View Settings for This Account.

Step 19 In the Account Settings dialog box, under the account that you just created, click Server Settings.

Step 20 Under Server Settings, click the Use Secure Connection (SSL) check box.

Caution If you do not configure Thunderbird to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
will not be encrypted.

Step 21 Click OK to close the Account Settings dialog box.

Troubleshooting IMAP Client Logon Problems
If users change their Cisco Unity Connection password from the Cisco Unity Assistant, they also must 
update this password from their IMAP client application so that the client can continue to access 
Connection and retrieve voice messages.

If users have trouble receiving voice messages in an IMAP client, consider the following information:

 • If the IMAP client application prompts a user for the Cisco PCA password, but does not accept it, 
the Cisco PCA password may have expired or changed, or is locked. Users can change their 
password from the Cisco Unity Assistant first and then update it from their IMAP client application.

 • If Microsoft Outlook users are not prompted for their Cisco PCA password, verify that the 
Remember Password check box on the Internet E-mail Settings (IMAP) page is not checked. If this 
option is checked, and the password of the user has expired, changed, or is locked, Microsoft 
Outlook will not prompt the user to enter the Cisco PCA password. The result is that the user will 
not receive voice messages from Connection, and Outlook will prompt for the user name and 
password. 
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Setting Up User Phones

This chapter lists tasks that you may want to do before users access Cisco Unity Connection by phone.

Task List for Setting Up User Phones
1. Set up Cisco Unity Connection to handle busy and unanswered calls. Enable call forwarding to 

Connection for each user phone, so that busy and unanswered calls to the user extension are 
transferred to Connection to handle. Connection then uses the call transfer settings specified for 
each user in Cisco Unity Connection Administration to determine, for example, whether callers will 
be put on hold or sent directly to the user greeting.

2. Specify a Messages button for user phones. Enable each user phone so that the user can use a 
Messages button or a similar speed-dial button on the phone to dial the internal Connection phone 
number for your organization. This makes calling Connection to check messages or to change 
personal settings by phone quick and easy for the user, as the user does not have to dial the number 
for Connection from his or her desk phone.

3. Specify phone and TTS languages for prompts. Phone languages are the languages in which 
Connection can play system prompts to users and callers; TTS languages are the languages in which 
Connection can play e-mail messages over the phone.

4. Install TTY prompts. A TTY prompt set, available in U.S. English (ENX) only, can be installed and 
used just like any other supported phone language. When the TTY prompt set is installed, users and 
outside callers who use TTY can call Connection and use the same features that a hearing caller can 
use.

However, note the following exceptions:

 • TTY tones are not available for use in navigating the Connection conversation.

 • Some TTY phones do not have the capability to send DTMF tones. In this case, TTY users may 
need to use the phone keypad for system navigation.

5. Change conversation defaults and enable conversation-specific features. You may want to change 
some default settings for the Connection conversation to ensure that users have an easier transition 
from a previous voice messaging system. (For example, you can change the default conversation 
version so that users hear menus that offer a more familiar keypad mapping.)

6. Enable features such as the Cisco Unity Personal Call Transfer Rules web tool, speech access for 
those users who prefer to use voice commands rather than touchtone phone keys, “Easy” Sign-In, 
system transfers, Text to Speech, and live reply.
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User Orientation

See the following sections in this chapter:

 • Orientation Task List, page 5-1

 • Settings That Users Can Change, page 5-3

Orientation Task List
After you create user accounts and set up the client applications that users will use to access Cisco Unity 
Connection from their phones and computers, use the following task list to acquaint users with 
Connection. If you are planning supplemental Connection training, also consider reviewing the potential 
user concerns and misconceptions listed in the “Support Desk Orientation” section on page 6-2.

1. Give each user a Cisco Unity Connection User Guide, a Cisco Unity Connection at a Glance card, 
a Connection Phone Menus and Shortcuts card, and/or the URLs to the document(s). The 
Cisco Unity Connection at a Glance and Connection Phone Menus and Shortcuts cards are provided 
in standard conversation and Optional Conversation 1 versions. (Cards are not available for any 
other conversation styles.) All user documentation is available at 
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.

2. Depending on the conversation version that users in your organization are familiar with, you may 
want to provide them with a list of phone menu differences between Connection and a former voice 
messaging system—especially if you choose not to offer them an alternative to the standard 
conversation, which is specified by default in the Voice Mail User template.

3. Give users the phone numbers that they dial to access Connection from within your organization and 
from outside the organization. As applicable, show users which button or key to use on their desk 
phones to access Connection.

Also give them the name and extension of the Connection administrator and any support desk 
contact information. There are spaces to record phone numbers and contacts in the Cisco Unity 
Connection User Guide, and in the Cisco Unity Connection at a Glance and Connection Phone 
Menus and Shortcuts cards.

4. Provide users with their initial phone passwords. Alternatively, tell users to log on to the 
Cisco Personal Communications Assistant (PCA) website to set their phone passwords before they 
call Connection to complete first-time enrollment. (Users are not required to enter an existing phone 
password in order to change it in the Cisco PCA.)

If users choose not to initially change their password in the Cisco PCA, they will be prompted to 
change their phone password during first-time enrollment.
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5. Make sure that users know that they need to complete first-time enrollment. They do not need to 
refer to any Connection documentation during enrollment. Connection indicates when the 
enrollment process is complete. If users hang up before they have completely enrolled, none of their 
changes are saved and the first-time enrollment conversation plays again the next time that they log 
on to Connection.

The “Getting Started” chapter of the Cisco Unity Connection User Guide details the tasks that users 
are asked to complete as part of enrollment.

6. Give users the URL to the Cisco PCA website: http://<Cisco Unity Connection server 
name>/ciscopca. There are spaces to record this URL in the Cisco Unity Connection User Guide, 
and in the Cisco Unity Connection at a Glance and Connection Phone Menus and Shortcuts cards.

Users use the Cisco PCA to access the Cisco Unity Assistant, Cisco Unity Inbox, and Cisco Unity 
Personal Call Transfer Rules, as applicable.

7. Explain to users how to secure their phone and Cisco PCA passwords so that they adequately protect 
their Connection mailboxes from unauthorized access. Detail the security guidelines for your 
organization.

Make sure users understand that their Cisco PCA passwords are not related to their Connection 
phone passwords, nor are the passwords synchronized. Users must use the Cisco Unity Assistant to 
change their Cisco PCA passwords.

8. Help users understand how Connection works with different types of messages, as applicable to your 
system configuration:

 • Users with voice mail access can customize the order in which messages are played for new, 
saved, and deleted messages.

 • Users who have access to e-mail messages via TTS, and who like to manage voice mail and 
e-mail messages separately, can turn on the Message Type menu so that they can pick which 
messages to hear by type (“Press 1 for voice messages, 2 for e-mails...”). Alternatively, users 
can use the Cisco Unity Assistant to specify that Connection will play e-mail messages last 
when they check messages by phone.

 • Users who have set up an IMAP client application to access voice messages may want to create 
a folder in their e-mail client to store voice messages separately from other messages.

Users can also use the Save Recording As option available from the Options menu on the Media 
Master to save voice messages as WAV files on their hard drives. Note, however, that private 
messages cannot be saved to the user hard drive. In addition, you can prohibit users from saving any 
messages to their hard drives, regardless of message sensitivity, by checking the Unity Inbox: 
Disable Save Recording As Option in Media Master check box on the System Settings > 
Advanced > PCA page in Cisco Unity Connection Administration. To prohibit users from saving 
any messages sent to an IMAP client, select the Allow Users to Access Message Bodies or the Allow 
Users to Access Message Bodies Except on Private Messages option when enabling users to access 
messages using the IMAP client on the Class of Service page.

9. Explain how full mailboxes work with Connection. See the “Support Desk Orientation” section on 
page 6-2 for issues that users may encounter. Refer users to the Cisco Unity Connection User Guide 
for similar information.

10. If your organization has users who will use TTY and the TTY prompt set, provide training on using 
TTY with Connection.

11. Make sure that users who own call handlers or system distribution lists understand their 
responsibilities (if applicable).

12. As applicable, tell users how to use the Cisco Unity Greetings Administrator and System Broadcast 
Administrator.
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13. Provide training on how to personalize user settings by using the phone and the Cisco Unity 
Assistant, as summarized in Table 5-1, “Settings That Users Can Change By Using the Cisco Unity 
Assistant and the Phone Menus.” In particular, users may benefit from a hands-on demonstration of 
the Cisco Unity Assistant, as they may not be accustomed to using a web interface to set voice 
messaging options.

14. Provide training on how to use the Cisco Unity Personal Call Transfer Rules web tool, and how call 
transfers, call holding and screening, and caller options are used, as summarized in Table 5-2, 
“Settings That Users Can Change By Using the Cisco Unity Personal Call Transfer Rules and the 
Phone Menus.”

Users can refer to the Cisco Unity Connection User Guide or to Cisco Unity Assistant Help for 
further guidance after orientation.

Settings That Users Can Change
Table 5-1 lists settings that users can change by using the Cisco Unity Assistant web tool and by phone.

Table 5-1 Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus 

Settings That Can Be Changed by Using the Cisco Unity 
Assistant Settings That Can Be Changed by Using the Phone Menus

Call Holding and Screening1:

 • Select how Connection handles indirect calls when 
the user phone is busy, including placing the caller on 
hold, prompting the caller to hold or leave a message, 
and sending the caller directly to the greeting

 • Select how Connection handles indirect calls, 
including telling the user who the call is for, 
announcing that Connection is transferring the call, 
prompting the user to accept or refuse a call, and 
prompting callers to say their names

Call Holding and Screening1:

 • None

Call Transfers2:

 • Transfer indirect calls to an extension or send to the 
greeting

 • Change extension

Call Transfers2:

 • Transfer indirect calls to an extension or send to the greeting

 • Change extension

Caller Options:

 • Allow callers to edit messages

 • Allow callers to mark messages urgent

Caller Options:

 • None
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Conversation Options:

 • Specify conversation input style

 • Set speed and language for Connection prompts

 • Select full or brief Connection conversation menus

 • Select the action that Connection performs when the 
user calls Connection, including greeting the user by 
name and announcing the number of new messages by 
type

 • Specify alternative extensions

Conversation Options:

 • Select full or brief Connection conversation menus

Greetings:

 • Record a personal greeting

 • Enable or disable greeting

 • Specify an expiration date for an enabled greeting

 • Switch between system prompt and personal greeting

Greetings:

 • Record a personal greeting

 • Enable or disable greeting

 • Specify an expiration date for an enabled greeting

Message Notification:

 • Enable or disable a notification device, and change its 
number

 • Specify dialing options

 • Select the types of messages and message urgency for 
which Connection will call a device

 • Set up a notification schedule, and specify what 
happens when a device does not answer, is busy, or 
fails

Message Notification:

 • Enable or disable a notification device, and change its 
number

Message Playback:

 • Specify message playback order

 • Change the time format used for message time stamps

 • Select the action that Connection performs when 
messages are played, including announcing the name 
and number of the sender who left a message, whether 
the timestamp is played before or after the message, 
and the volume level at which messages are played

 • Specify whether Connection plays the Message Type 
menu

Message Playback:

 • Speed and volume of message as it is played

Message Addressing:

 • Switch between addressing messages to other users 
by name, or by extension

 • Specify order for addressing messages by name (last 
name followed by first name, or vice versa)

Message Addressing:

 • Switch between addressing to other users by name or by 
extension (by pressing ##)3

Table 5-1 Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus (continued)

Settings That Can Be Changed by Using the Cisco Unity 
Assistant Settings That Can Be Changed by Using the Phone Menus
5-4
Cisco Unity Connection 1.x User Setup Guide

OL-8471-03



  

Chapter 5      User Orientation
  Settings That Users Can Change
Table 5-2 lists settings that users can change by using the Cisco Unity Personal Call Transfer Rules web 
tool and by phone.

Personal Settings:

 • Record a name

 • Specify alternate names

 • Change directory listing status

 • Change password

Personal Settings:

 • Record a name

 • Change directory listing status

 • Change password

Private Lists:

 • Enter a display name

 • Record a list name

 • Add and delete members

Private Lists:

 • Record a list name

 • Add and delete members

1. These settings apply if the user does not have Cisco Unity Personal Call Transfer Rules enabled. Call holding and screening options apply only to 
incoming calls that were routed to the user from the automated attendant or a directory handler, and not on direct calls. Holding and screening options do 
not apply when an outside caller or another user dials a user extension directly. In addition, holding and screening options are only available when 
supervised transfers are enabled.

2. These settings apply if the user does not have Cisco Unity Personal Call Transfer Rules enabled. Call transfer options apply only to incoming calls that 
were routed to the user from the automated attendant or a directory handler, and not on direct calls. Transfer options do not apply when an outside caller 
or another user dials a user extension directly.

3. Note that this depends on whether you have enabled spelled name addressing.

Table 5-1 Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus (continued)

Settings That Can Be Changed by Using the Cisco Unity 
Assistant Settings That Can Be Changed by Using the Phone Menus

Table 5-2 Settings That Users Can Change By Using the Cisco Unity Personal Call Transfer Rules and the Phone 

Menus 

Settings That Can Be Changed by Using the Cisco Unity 
Personal Call Transfer Rules Settings That Can Be Changed by Using the Phone Menus

Call Holding and Screening:

 • Set up personal call transfer rules to specify how 
Connection handles direct and indirect calls when the 
user phone is busy, including placing the caller on 
hold, prompting the caller to hold or leave a message, 
and sending the caller directly to the greeting

 • Set up personal call transfer rules to specify how 
Connection handles direct and indirect calls, 
including telling the user who the call is for, 
announcing that Connection is transferring the call, 
prompting the user to accept or refuse a call, and 
prompting callers to say their names

Call Holding and Screening:

 • None
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Call Transfers:

 • Set up personal call transfer rules to transfer direct 
and indirect calls to an extension, to an external phone 
number, or to the greeting

Call Transfers:

 • Enable or disable personal call transfer rules to transfer 
direct or indirect calls to an extension, to an external phone 
number, or to the greeting

 • Enable or disable the Transfer All rule set to forward all calls 
to voice mail or to another phone number

 • Forward all incoming calls directly to Connection, rather 
than to phone extension

Caller Options:

 • Allow callers to edit messages

 • Allow callers to mark messages urgent

Caller Options:

 • None

Destinations:

 • Set up phone numbers or notification devices to use 
when transferring calls

 • Set up groups of destinations to use in personal call 
transfer rules

 • Specify the number of rings that Connection waits 
before transferring the call to the next destination or 
to voice mail

Destinations:

 • None

Personal Contacts:

 • Set up an address book of personal contacts to use for 
both name dialing and call transfer rules

Personal Contacts:

 • None

Caller Groups

 • Create groups of personal contacts, system contacts, 
or Connection users to use in personal call transfer 
rules

Caller Groups

 • None

Table 5-2 Settings That Users Can Change By Using the Cisco Unity Personal Call Transfer Rules and the Phone 

Menus (continued)

Settings That Can Be Changed by Using the Cisco Unity 
Personal Call Transfer Rules Settings That Can Be Changed by Using the Phone Menus
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Operator and Support Desk Orientation

Operators in your organization need information about Cisco Unity Connection that is specific to your 
installation. In addition, if your organization has a support desk, the staff will need to be prepared to 
answer the questions that users may ask, and to be aware of the resources that are available to assist them 
in answering user questions.

See the following sections in this chapter:

 • Operator Orientation, page 6-1

 • Support Desk Orientation, page 6-2

Operator Orientation
Operator orientation should address the same points as user orientation, but in greater detail. Operators 
must be familiar with how users use Cisco Unity Connection. Depending on the size of your 
organization, the operator may be the person users are likely to ask when they have questions about 
Connection.

In addition to the information in the “User Orientation” chapter and the “Support Desk Orientation” 
section on page 6-2 (as applicable), operators also need to understand the following concepts and tasks:

Roles of the Operator and the Automated Attendant

The way your organization uses the automated attendant determines what the operator responsibilities 
are. The automated attendant is a call handler that is used in place of a human operator to answer and 
direct calls by playing greetings and responding to touchtones. The automated attendant can provide a 
menu of options (for example, “For Sales, press 1; for Service, press 2.”), and it can also provide 
information (for example, “Our normal business hours are Monday through Friday, 8 a.m. to 5 p.m.”).

Directing Calls

Regardless of how your organization uses the automated attendant, many calls will go to the operator. 
The operator must know how to direct calls to voice mail and to user phones. With Cisco CallManager, 
you can program the phone to direct calls to voice mail. For details on setting this up, see the tech note 
How to Transfer a Caller Directly into a Mailbox, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_tech_notes_list.html.

Forwarding Messages to Intended Recipients

If an operator also owns a call handler or system distribution list, make sure that the operator knows to 
review messages frequently, and to forward messages as necessary to the applicable recipient(s).
6-1
 Unity Connection 1.x User Setup Guide

http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_tech_notes_list.html


  

Chapter 6      Operator and Support Desk Orientation
  Support Desk Orientation
Using the Cisco Unity Greetings Administrator

An operator who is responsible for changing call handler greetings for the organization can use the 
Cisco Unity Greetings Administrator when it is not practical to change a greeting in Cisco Unity 
Connection Administration. For example, if the office is unexpectedly closed because of bad weather, 
the operator can call from home to use the Cisco Unity Greetings Administrator to enable the alternate 
Opening Greeting, or to rerecord a call handler greeting stating that the office is closed. For information 
on using the Cisco Unity Greetings Administrator, see the Cisco Unity Connection System 
Administration Guide, at 
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.

Using the Cisco Unity Broadcast Message Administrator

If an operator will be responsible for sending recorded announcements to everyone in an organization 
(or to particular location(s) within an organization), explain how to access and use the Cisco Unity 
Broadcast Message Administrator to send broadcast messages. For information on using the Cisco Unity 
Broadcast Message Administrator, see the Cisco Unity Connection System Administration Guide, at 
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.

Support Desk Orientation
Support desk orientation should address the same points as user and operator orientation, but in greater 
detail. Support desk staff must be familiar with how users and operators use Cisco Unity Connection, 
and the common problems that users may encounter when using Connection. Instead of using the 
Connection server, it may be helpful to set up a test server that support desk staff can use to browse to 
Cisco Unity Connection Administration, and troubleshoot and test client applications.

To prepare for possible calls to the support desk at your organization, familiarize the support desk staff 
with the resources listed in the “Support Desk Resources” section below, and with the potential user 
concerns and misconceptions listed in the “Potential User Concerns and Misconceptions” section on 
page 6-3. (See also the“Operator Orientation” section on page 6-1 and the “User Orientation” chapter.)

Support Desk Resources
 • User documentation is available at 

http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html. In particular, 
support desk staff may find the Cisco Unity Connection at a Glance documents helpful in gaining a 
high-level visual understanding of the flow of the Connection conversation.

 • The Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations is 
available at 
http://www.cisco.com/en/US/products/ps6509/products_device_support_tables_list.html.

 • The following chapters in this guide provide information on how user workstations should be set up, 
and describes how users use Connection client applications:

 – Setting Up Access to the Cisco Personal Communications Assistant

 – Setting Up Playback and Recording Devices for the Media Master

 – Configuring an E-Mail Account to Access Cisco Unity Connection Voice Messages

 – Setting Up User Phones
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 • For descriptions and the URLs of all Connection documentation on Cisco.com, see the Cisco Unity 
Connection Documentation Guide. The document is shipped with Connection and is available at 
http://www.cisco.com/en/US/products/ps6509/products_documentation_roadmaps_list.html.

Potential User Concerns and Misconceptions
Table 6-1 describes potential user issues, which are typically based on misconceptions about how 
Cisco Unity Connection works. Users who encounter such issues are often those who are accustomed to 
another voice messaging system, have not yet completed Connection training, or are unaware of a new 
feature or functionality change to an existing system.

Table 6-1 Potential User Concerns and Misconceptions 

Potential Issue Description

Cisco Personal 
Communications 
Assistant security alerts 
when using SSL

If your organization set up Cisco Unity Connection to use SSL, but did not add it to the Group 
Policy in order to distribute the certificate to the trusted root store for all users in the domain (or 
did not tell users how to add the certificate to the trusted root store on their own computers), users 
may be concerned about the security alert that will be displayed each time that they access the 
Cisco PCA. Tell users that they can ignore the warning and proceed to use the Cisco PCA without 
doing any harm to their computers or the network.

To prevent the browser from displaying the security alert, see the “Managing Security Alerts When 
Using SSL” section on page 1-5.

Delayed messages Users may believe that their messages are delayed for the following reasons:

 • While listening to new messages, users may skip a message and inadvertently mark it new. 
Later, when they check messages again, they hear the skipped message and believe that the 
message arrived after a delay.

 • Users may skip more messages than they intend while listening to their messages, and later 
check messages again only to hear one or more of the skipped messages, and believe that the 
message(s) arrived after a delay.

 • While listening to messages, other new messages arrive that users may not be aware of. Later, 
when they check messages again, they hear the new message(s) and believe that they were 
delayed.

Deleted messages By default, when users delete a new or saved message, Cisco Unity Connection does not ask them 
to confirm the deletion. You may want to enable Connection to request confirmation from users 
before proceeding with the deletion, especially if many users do not belong to a class of service that 
allows them to retain and review their deleted messages. You can set up Connection to confirm 
deletion of messages on the System Settings > Advanced > Conversations page in Cisco Unity 
Connection Administration.

For information on deleted messages, refer users to the “Deleting Messages” chapter of the 
Cisco Unity Connection User Guide, available at 
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.
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Deleted messages: 
IMAP and MAPI 
behavior

When users access messages stored on a Microsoft Exchange server both from a Microsoft Outlook 
client and from Cisco Unity Connection, they may experience unexpected and confusing behavior 
when deleting messages. The difference in behavior occurs when the Microsoft Outlook client is 
configured to use MAPI, the Microsoft interface for connecting to Exchange, and stems from the 
fact that MAPI and IMAP—the protocol used by Connection—use different mechanisms for 
marking messages as deleted.

If you have users who access a Microsoft Exchange server by using Outlook (with MAPI) or 
Outlook Web Access, and who also use Connection to manage messages on the same message store, 
be sure to alert them to this behavior.

Deleted Messages—IMAP Behavior

When a user deletes a message from Microsoft Outlook, the message is moved from the Inbox to 
the Deleted Items folder. At this point, Connection can no longer access the message, and will no 
longer indicate that the message exists either as a new, saved, or deleted message.

Deleted Messages—MAPI Behavior

When a user deletes a message from Connection, the message remains in the Inbox but is flagged 
to indicate that it has been marked deleted by the user. However, when configured to use MAPI, 
Microsoft Outlook does not recognize this flag as a deletion, and will continue to display the 
message as a new or saved message in the Inbox.

Directory listing: users 
are not listed as 
expected

When users do not have a recorded name, they are not listed in the phone directory and as a result, 
outside callers are not be able to find them when searching for them by name. By default, 
Cisco Unity Connection prompts users to record a name during first-time enrollment, but it does 
not prevent them from completing the enrollment process if they do not.

To address this issue, consider the following options:

 • You can change whether recording a name is required to complete first-time enrollment on the 
System Settings > Advanced > Conversations page in Cisco Unity Connection Administration.

 • You can provide recorded names for users in Cisco Unity Connection Administration.

 • Users with class of service rights can record their own names by using the Connection 
conversation or the Cisco Unity Assistant.

Note This problem does not occur for internal users, but only for outside callers; Cisco Unity 
Connection users who address messages by name will still be able to find other users even 
if they have not recorded a voice name.

Table 6-1 Potential User Concerns and Misconceptions (continued)

Potential Issue Description
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IMAP client: 
Differences in client 
behavior

Users who use different third-party IMAP clients to access voice messages from their desktop 
machines may note the following discrepancies in behavior:

 • Microsoft Outlook client:

 – For new messages, the “Mark as Unread” feature will mark messages as new on the 
Cisco Unity Connection server, regardless of whether the WAV file message attachment is 
downloaded or not.

 – Voice messages that are deleted over the phone are marked for deletion in the Outlook 
client and are changed to strikethrough text when users select the “Send/Receive” 
command.

 • Novell GroupWise client:

 – When new messages with the WAV file message attachment have been downloaded to the 
GroupWise client, the “Read Later” feature no longer marks the message as new on the 
Connection server.

 – Voice messages that are deleted over the phone are not marked for deletion in GroupWise; 
users will need to manually delete them from this client.

 – GroupWise users will need to use the “Send/Retrieve” command to update message status 
from the Connection server.

Mailbox fills up quickly Users may complain that their mailboxes are filling up too quickly, for any of the following reasons:

 • Cisco Unity Connection does not automatically delete messages when they reach a certain age. 
This means that user messages are saved until the user deletes them permanently. (For 
information on how to permanently delete messages, refer users to the “Deleting Messages” 
chapter of the Cisco Unity Connection User Guide, available at 
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.)

 • When users receive nondelivery receipts (NDRs) to messages that they send, their e-mail client 
mailbox can quickly increase in size—especially if the original message included large 
attachments. For users who have access to e-mail messages via TTS, if their e-mail clients are 
configured to save their sent messages, the original message and attachments are stored in their 
Sent Items folders and another copy is sent to their Inboxes along with the NDR, increasing 
their mailbox size accordingly.

 • Users may receive messages that have been forwarded many times over, which increases 
message size. The original message plus all recorded introductions that were added during 
forwarding equal the total message size. As a result, users who have relatively few messages 
stored in their mailboxes may still find that their mailboxes exceed the storage limits.

 • User mailboxes can fill up while users are on vacation or on an extended leave of absence. To 
prevent this, specify that Connection will prevent callers from leaving messages when users 
have their alternate greetings enabled.

Table 6-1 Potential User Concerns and Misconceptions (continued)

Potential Issue Description
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Managing multiple 
message types

Users who are new to Cisco Unity Connection sometimes have a difficult time understanding how 
to manage multiple message types from a single Inbox. 

Depending on your system configuration:

 • Users with voice mail access can customize the order in which messages are played for new, 
saved, and deleted messages.

 • Users who have access to e-mail messages via TTS, and who like to manage voice mail and 
e-mail messages separately, can turn on the Message Type menu so that they can pick which 
messages to hear by type (“Press 1 for voice messages, 2 for e-mails...”). Alternatively, users 
can use the Cisco Unity Assistant to specify that Connection will play e-mail messages last 
when they check messages by phone.

 • Users who have set up an IMAP client application to access voice messages may want to create 
a folder in their e-mail client to store voice messages separately from other messages.

Users can also use the Save Recording As option available from the Options menu on the Media 
Master to save voice messages as WAV files on their hard drives. Note, however, that private 
messages cannot be saved to the user hard drive. In addition, you can prohibit users from saving any 
messages to their hard drives, regardless of message sensitivity, by checking the Unity Inbox: 
Disable Save Recording As Option in Media Master check box on the System Settings > 
Advanced > PCA page in Cisco Unity Connection Administration.

Message notification: 
repeat notification 
options

When a user chooses not to have Cisco Unity Connection restart notification each time a new 
message arrives, setting a long interval between repeat notification calls may lead the user to believe 
that Connection is delaying notification.

Passwords are not 
secure, or users use the 
wrong password

Users may assume that their phone and Cisco Personal Communications Assistant (PCA) 
passwords are the same or are synchronized. As a result, they may think that they are changing both 
passwords when Cisco Unity Connection prompts them to change their phone password during 
first-time enrollment. Additionally, they may try to use their phone password to log on to the 
Cisco PCA.

Secure messaging: 
limitations

To set user expectations for this feature, it is important to tell users, administrators, and help desk 
staff about the following limitations of the private and secure messaging feature:

 • When users leave a voice message after calling another user and being transferred to voice mail, 
they cannot mark the message private or secure.

 • The private keys that are required to decrypt secure messages are not specific to individual 
users or workstations. Thus, if a secure message is sent to an unintended recipient—perhaps 
because of an addressing mistake made by the sender or due to a system problem—Cisco Unity 
Connection will play the message for any recipient who receives the message as long as the 
recipient is homed on the same Connection server as the sender.

 • From an IMAP client, a user cannot send a secure message, nor can the user retrieve a secure 
message. If the user tries to listen to a secure message, a decoy message will instead be played, 
telling the user to log on to Connection by phone to listen to the message.

 • When you enable the Encrypt All Messages from Outside Callers and the Encrypt All Private 
Messages from Users settings on the System Settings > Advanced > Secure Messaging page, 
users will not be able to use IMAP clients to listen to any messages. Instead, they will need to 
listen to messages from the Connection conversation.

Table 6-1 Potential User Concerns and Misconceptions (continued)

Potential Issue Description
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Speed for elements of 
the Connection 
conversation varies

Users may report that the speed at which Cisco Unity Connection plays menus, voice names, 
greetings, and messages is inconsistent. For example, users may report that when they listen to their 
messages, the message is played at a different speed than the voice names of users who leave them 
messages and the message properties (for example, the timestamp and message number).

Such inconsistencies are expected when you consider the following:

 • Connection plays recorded names and greetings at the speed at which they were recorded. 
Neither you nor users can affect the playback speed of recorded names and greetings.

 • Messages played via Text to Speech (TTS) are always played at normal speed by default, 
regardless of message playback settings.

 • The speed that you or a user specifies for system prompts—the standard recordings that come 
with the Connection system, including prompts for message properties—does not affect the 
playback speed of messages.

 • The speed that users specify for message playback does not affect system prompts.

Unread messages Depending on how Cisco Unity Connection is set up at your organization, users may be surprised 
at how Connection handles messages when calls are intentionally or unintentionally disconnected 
(for example, when a user hangs up or when a cell phone loses its charge or signal) while users are 
in the process of listening to new messages. Some users may incorrectly assume that Connection 
marks the message as read, which is not the case.

You can change how Connection handles unread messages when calls are disconnected by adjusting 
the “Mark Message Saved If User Hangs Up” setting on the System Settings > Advanced > 
Conversations page of Cisco Unity Connection Administration.

Unsent messages Depending on how Cisco Unity Connection is set up at your organization, users may be surprised 
at how Connection handles messages when calls are intentionally or unintentionally disconnected 
(for example, when a user hangs up or when a cell phone loses its charge or signal) while users are 
in the process of sending, replying to, or forwarding a message. Some users may incorrectly assume 
that Connection offers a draft folder for unsent messages, which is not the case.

You can change how Connection handles unsent messages when calls are disconnected by adjusting 
the “Send Message If User Hangs Up During Recording” setting on the System Settings > 
Advanced > Conversations page of Cisco Unity Connection Administration.

Table 6-1 Potential User Concerns and Misconceptions (continued)

Potential Issue Description
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